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Determination of copper in a blue print by ICP-OES 
 

Nowadays, analytical chemistry encounters the necessity of quantitative determination of elements 

in samples of all kind of states. Liquid and gas samples can be easily carried into flame or analytical 

plasma such as widely used inductively coupled plasma (ICP). If there is no possibility, or we just 

don’t want to bring samples directly into excitation source by spark or laser ablation, it is necessary 

to transform solid and suspense samples into liquid solution. One of the common ways is to dissolve 

the sample in acid solution or in a mixture of acids with addition of other reagents. However, the 

correct procedure depends on the type of sample. Visible dissolution of sample does not necessarily 

mean that the sample was quantitatively dissolved or that there wasn’t loss of one of the sample’s 

component. Efficiency and the speed of the decomposition can be increased for instance by 

increasing temperature using a heating source or even better by microwave decomposition system. 

Furthermore, it’s much easier to dissolve powder sample with small particles, than monoliths such as 

stones or metals. For this purpose, there is more than a one method; most common are blending or 

grinding. Grinding and homogenisation of sample are often necessary steps in sample preparation of 

tablets before X-ray analysis or laser ablation with ICP.    

This task concerns the use of modern methods of a microwave decomposition and a cryogenic 

grinding for a solid sample preparation and analysis of this sample using ICP. A paper with a blue 

colour ink from basic PC printer is a good sample to demonstrate microwave decomposition as well 

as cryogenic grinding for copper determination in this ink. 

Cryogenic grinding for sample preparation 
 

Cryogenic grinding is based on cooling samples to 

cryogenic temperatures using liquid nitrogen, then 

pulverizes them by magnetically shuttling a steel 

impactor back and forth against two stationary  

end-plugs in a closed vial. This method makes it 

possible to grind even materials sensitive to heat or 

materials that are impossible to grind at normal 

temperature such as thermoplastics, hairs, textile 

or organic tissues. Cryogenic grinding is mostly 

suitable for materials that are soft and flexible at 

room temperature. Extremely low temperatures 

during the grinding suppress recrystallization and 

leads to finer grain structures.  

Major advantages of cryogenic grinding are higher 

yield of fine particles in target range and uniform 

particle size distribution. 

 
 

Fig. 1 Cryogenic mill 6775 Freezer/Mill 
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Procedure: 
 

1.) Sample preparation 

Blue square is printed on paper by an ink printer.  Area of the printed 
colour is 10x10 cm. This sample is then cut into small squares  
ca. 1x1 cm and put into grinding vial (Fig. 2) with a steel impactor. 

Along with the sample it is necessary to prepare a blank sample; in 

this case it is pure unprinted paper. Given the fact, that grinding takes 

about 25 minutes, it is best to prepare blank sample during the 

sample grinding.  

 

2.) Grinding 

Vial with the sample is placed into the mill in the vial slot. It is essential 

to check the amount of liquid nitrogen in the container (the level of 

nitrogen cannot drop more than 2 cm below the top edge of the 

container). Afterwards, the container is closed and secured with rubber 

clip. Programme for paper grinding is started from the screen. 

Parameters for paper grinding are shown in table 1. 

 

3.) Sample removal 

When the programme finishes, the freezer mill is opened and the vial is 

removed using magnetic pen. Be careful when handling the vial, its 

metal parts are frozen to cryogenic temperature. Then the vial is 

opened using opener (Fig. 3) by removing the plug. Grinded sample is 

then spilled on filter 

paper and placed into 

exicator.  

4.) Microwave decomposition 

 

Microwave decomposition is commonly used for 

sample dissolution prior to elemental analysis 

using methods ICP-MS, ICP-OES or AAS. 

Advantages of microwave decomposition are 

shortening of the time of the analysis, reducing of 

the amount of acid needed, reducing of the risk of 

contamination or decomposition of samples, that 

are difficult to decompose. Microwave 

decomposition can be either in open system (at 

atmospheric pressure) or closed system. In open 

systems, the boiling point of the acid establishes 

parameter value 
Precooling 15 min 
Grinding 1,5 min 
Cooling 2 min 
Nr. of cycles 3 
rate 12 cps 

Tab. 1 Grinding parameters  

Fig. 2 Grinding vials  

Pic. 3 Grinding vial opener 

Fig. 4 Microwave system ETHOS ONE 
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the maximum decomposition temperature, whereas in closed systems is maximum limited to 250°C.  

Usually, different mineral acids are used for sample decomposition (e.g. HCl, HNO3, HF, H2SO4…) or 

hydrogen peroxide. Vials for decomposition are made of inert material (such as teflon) which are 

transparent for microwave radiation. Heating by microwave radiation depends on type of the 

sample, therefore it is necessary to monitor temperature of samples. Decomposition will be carried 

out in microwave decomposition system ETHOS ONE (Fig. 4). 

Principles of working with microwave decomposition system 

 Vials must be clean and dry, therefore it is necessary to use gloves when operating. 

 Vials and their caps are numbered, it is necessary to keep sets together. 

 Output from microwave system leads to hood, which must be always on. 

 Vial number 1, reference vial with thermal sensor, must always be at position 1. In this vial, 

temperature is measured, therefore it is crucial to use it for a sample, not a blank. 

Reagents 
6ml HNO3 (65%), 2ml H2O2 (30%) 

Programme 

Step Time Energy T1 T2 
1 00:15:00  200 ramp time 
2 
3 

00:15:00 
00:10:00 

 200 
- 

decomposition 
cooling 

Tab. 2 Parameters for temperature programme 

Procedure: 
 

1.) Sample preparation 

0,1 g of sample is put into decomposition vial 

and using acid. (Fig. 5). Analogously, blank 

sample is put into second vial. Both vials are 

put into safety cover and then the whole 

segment is closed (Fig. 6.). Using torque 

wrench the pressure gauge is tightened until 

it clicks. Now the segments are ready to be 

put into microwave system. It is necessary to 

put there at least 3 vials, so the system is 

balanced. Therefore, we use same amount of 

acids in the 3rd vial. All 3 segments are evenly 

embedded into microwave system.  

 

 

 

 

 

Fig. 6 Segment for decomposition of one 
sample 

Fig. 5 Vial for 
microwave 
decomposition 
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Choosing a position on Samples touch 

screen (Fig. 7) will rotate the disk so that the 

chosen position is in the front. Reference 

vial is placed in the position 1 as the last 

one. After placing all segments except the 

reference one, an upper disc is placed on 

top of them as shown on Fig. 8. Then the 

reference segment is placed and the 

thermal sensor is connected via cable. 

Lastly, the upper disc is fitted onto all 

segments so that all segments are fixed.  

 

 

 

 

 

 

 

 

 

 

2.) Programme settings  

It is important to check all boxes on the 

home screen exactly as is shown on Fig. 9. 

Be sure to check the TWIST button, without 

it the cable of thermal sensor would be torn 

up. It is possible to check the correct 

rotation of the rotor using button with a fan. 

(Fig. 10). 

 

 

 

Fig. 7 Sample screen 

Fig. 8 Segments with upper disc 

Output of thermal sensor 

Upper disc  

Segment with sample 

Bottom disc with 

positions 

Fig. 9 Settings home screen 

Fig. 10 Rotation control button 
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Setting of the thermal programme is done 

in the Method tab. Table is filled with 

parameters for microwave decomposition 

programme. Step 1 is the time of the 

gradient increase of the temperature until 

the required temperature is reached. Step 

2 is the time of stable temperature. The 

graph above the table shows temperature 

profile of the programme. Using save 

button is the method saved. If the method 

was already created, it is possible to load it 

from saved files using load button. 

 

To launch the programme the Start button 

(in the Run tab) is pushed. The progress of 

the decomposition is shown on the Run 

screen. (pic. 12). The door is automatically 

locked at 80 °C. after the decomposition it is 

necessary to wait until the temperature of 

the samples drops to about 50 °C.  After that 

it is possible to remove them from 

microwave and open them using torque 

wrench.  Samples are then quantitatively 

transferred into 25 ml volumetric flasks. 

 

 

Inductively coupled plasma optical emission spectrometry (ICP-OES) 
ICP-OES is an analytical method based on the determination of the intensity of emitted light from 
excited atoms and ions.  Sample is introduced into the ICP as liquid form using nebuliser. Inside of 
ICP, aerosol is evaporated and dried. The plasma excites atoms, which leads to photon emission and 
ionization. Deexcitation causes radiation at the characteristic wavelengths of the elements involved, 
and its intensity is measured with detector. Emission spectra of atoms an ions offers qualitative 
information (wavelength) as well as quantitative information (intensity). 

 

 Atomisation and excitation source 
The excitation source must desolvate, atomize, and excite the analyte atoms. As atomisation 

and excitation source in ICP-OES is used electrical discharge, that creates inductively coupled 

plasma. An inductively coupled plasma can be generated by directing the energy of a radio 

frequency generator into a suitable gas, usually ICP argon. This plasma has high electron 

density and temperature (10000K) and its energy is used in the excitation-emission of the 

atoms from the sample. 

 

Fig. 11 Method tab 

Fig. 12 Run tab 
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 Optics of spectral instrument 
Electromagnetic radiation is emitted during deexcitation of particles inside of the plasma. 
This radiation consists of analytically important radiation of atoms and ions of the sample 
and radiation of non-dissociated molecules (OH, CO, N2…), which does not carry analytical 
information and therefore creates noise. For analytical purposes, it is necessary to split this 
polychromatic radiation to individual components (emission lines), which are characteristic 
for elements. For this purpose, a dispersive element is used, such as prisms, gratings or 
filters. This component is one of the most important part of an ICP optical spectrometer, 
since it is their quality that has the major impact on resolution. Prisms and filters don’t 
achieve resolution needed for ICP-OES and therefore only gratings are used. Based on the 
type of grating, ICP-OES spectrometers can be divided into 3 groups:   
   

 spectrometer with planar diffraction grating Czerny-Turner 

 spectrometer with concave diffraction grating Paschen-Runge 

 spectrometer with echelle grating  

Deretmination of Cu in the sample will 

be carried out using ICP spectrometer 

iCAP 6500 Duo (Thermo Scientific). ICP 

spectrometer contains echelle 

monochromator with grating with 52,9 

grooves per mm. This system offers 

simultaneous measuring of spectrum in 

the range 166 –847 nm. 

 

 

 

 

 

 

 

Procedure: 

1.) Sample and calibration standards preparation 

Calibration standards with concentration of Cu2+ 1 mg/l, 0,5 mg/l a 0,1 mg/l a 0 mg/l is 
prepared from calibration standard Astasol (cCu = 1 g/l). It is important to add the same 
amount of acid to each calibration solution as was added to sample. Samples don’t need to 
be adjusted anymore.  

 

 

 

 

 

 

 

Fig. 14 ICP Spectrometer ICAP 6000 series 
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2.) Method settings 

 

Spectrometer is controlled using 

programme iTEVA (Pic. 15). At the bottom 

bar choose lock icon, which opens 

„Interlocks“ window, where actual state 

of spectrometer is shown (communication 

with PC, exhaust system,…) including 

actual temperature of detector (Fig. 16).  

If any of Interlocks is red and the 

temperature of the detector is 

-45°C, it is possible to 

start plasma. 

 

 

 

 

 

Icon of the burner will open window with 

the table „Plasma status“ (Fig. 17), where 

the button Plasma On is chosen. On the 

home screen of iTEVA choose the tab 

Analyst. New method is created as follows: 

  Method => New 

 

 

 

 

  

 

 

 

 

 

Fig. 15 Home screen of iTEVA 

Fig. 16 Instrument status 

Fig. 17 Plasma status 

Fig. 18 Periodic table for the choice of elements 

Fig. 12 Selection of Cu lines 



10 
 

Fig. 20 Method settings tabs 

Window with a periodic table is opened (Fig. 18.). Measured lines of Cu are selected after the 

selection of measured element – Cu. (pic. 19.). Although, individual lines are sorted based on 

their intensity, it is necessary to control interferences (right part). 

 

 

 

 

 

 

 

 

 

From method settings tabs (Fig. 20.) 

choose Analysis Preferences (Fig. 21.) 

and select axial view, which is often 

used for determination of elements 

with low content in samples with 

simple matrix. Axially viewed plasma 

system looks down the central 

channel of the plasma and collects all 

the analyte emission over the entire 

length of the plasma. In radial plasma, 

spectrometer views the analyte 

emission from the side of the plasma 

through the background argon 

emission. 

 

 

In Source Settings (Fig. 22.) set up 

following parameters: 

 

Parameter Value 
Flush pump rate 75 rpm 
Analysis pump rate 25 rpm 
Pump stabilisation time 5 s 
Nebuliser gas flow 0,65 L/min 

Tab. 3 Parameters for measurement 

Fig. 21 Analysis preferences 

Fig. 22 Source settings 
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Pic. 27  Publisher icon 

 

 

For each standard, set its 

concentration in Standards 

window (Fig. 23.). If needed, 

using Add button it is possible 

to add more standards. As 

next step save the method 

and choose Analyst tab. 

 

3.) Calibration and analysis 

 

 

Fig. 24 Upper bar with icons 

Open the calibration window (Fig. 25.) by pressinng 

a button with purple beaker (Fig. 24.) at the upper 

bar. Immerse the nebulizer sample tube into 

calibration blank and start the measurement by 

pressing Run button. Analogously measure the 

calibration solutions. After measuring all the 

calibration standards finish the measurement by 

pressing the button Done. Analysis of sample is 

started by pressing the green beaker (Fig. 24.). It is 

good to check stability when measuring large 

number of samples by measuring one of the 

standards at the end of the measurement again.  

 

 

4.) Data export 

 

Fig. 23 Standards settings 

Fig. 25 Calibration window 

Pic. 26 Selection of samples 
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Measured data are exported using the Publisher icon (pic. 27.), right below the Analyst icon.   

New report => Sample report => OK 

In Sample query window (pic. 26.) set the date of measurement and select method used. Select 

analysed samples from the list for which data are to be exported. Select the sample and press 

OK.  

Data file is exported as follows: 

 Export => Excel => Save 

 

Data evaluation 
The precision of the result is limited by the random errors. Random errors in experimental 

measurements are caused by unknown and unpredictable changes in the experiment. Random errors 

often have a Gaussian normal distribution. The mean m of measurements of the same quantity is the 

best estimate of that quantity, and the standard deviation s of the measurements shows the 

accuracy of the estimate. When number of measurements is small n << 10, instead of standard 

deviation is calculated from range R:  

𝑠𝑅 =  𝑘𝑛 ∙ 𝑅 

Where kn is Dean-Dixon coefficient (k3 = 0,5908). 

Confidence interval 

Confidence intervals consist of a range of values (interval) that act as good estimates of the unknown 

value. Dean-Dixon tailored a method of the calculation of confidence interval for small sample size 

datasets:   

𝐿1,2 =  �̅�  ±  𝐾𝛼  ∙ 𝑅 

where Kα is critical value of Lord distribution for confidence level α. 

(for α=0,05 k3 = 1,304) 

Limit of detection and limit of quantification 

These limits are calculated from value �̅�𝐵 (mean of 10 measurements of blank) and the standard 

deviation �̅�𝐵 (also calculated from 10 measurements of blank). 

LoD = �̅�𝐵 + 3�̅�𝐵 

LoQ = �̅�𝐵 + 10�̅�𝐵 

Hypothesis testing 

Two-sample test for a difference in mean is used when measuring sample by 2 different methods. 

When the number of measurements (nA = nB = n) is most often done by simplified Student t-test. For 

small size datasets is commonly used the Lord test: 

𝑢 =  
|�̅�𝐴 − �̅�𝐵|

𝑅𝐴 + 𝑅𝐵
 

If the value of u is greater than critical value of Lord test at the chosen significance level α, the 

difference in means is statistically significant. In that case the results from different measurements 

cannot be considered as identical (for α=0,05 uα = 0,636) 
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Fig. 1: Schema of ICP-MS. (http://www.chem-agilent.com/contents.php?id=53926) 

Determination of copper in a blue print by ICP-MS 

Principle of ICP – MS  

Liquid sample is transformed to the aerosol by nebuliser and transported to the inductively 

coupled of plasma with its temperature between 6 000 and 10 000 K (depending on plasma 

region). Here is aerosol dried, evaporated, atomized and ionized. In ICP the ionization occurs 

into the first degree only, except alkali metals and rare earth elements. Ions created in the ICP 

source enter into mass spectrometer via interface system. The interface consists of sampler 

and skimmer cones and there is an effective separation of argon flow from atoms and ions 

flow occurred here. First the plasma beam (ions and atoms from the sample and carrier gas) 

go through the sampler cone into pre-vacuum space with pressure of 100 Pa, approximately. 

The supersonic expansion occurs with subsequent cooling of the plasma beam. Then it enters 

into ion optic via skimmer. The ion optic serves to focusing of the beam and removing of 

photons and non-charged atoms that would increase the background level of the detector. 

Focused ion beam enters into collision-reaction cell filled with He that suppress possible 

polyatomic interferences. Then the ions are separated in the quadrupole analyser according to 

their mass to charge ratio (m/z) and ions with selected m/z exit from the analyser and hit the 

electron multiplier that generates signal (Fig. 1). For more details of ICP see instruction LA-

ICP-MS. 

 

 

 

 

 

 

 

 

 

 

The aim of this practicum is: 

 

a) to quantitative deremine the total content of copper in ink (blue color) 

b) to prepare calibration standards for determination of copper 

c) to learn how to measure on ICP-MS 

d) to calculate the limit of detection (LOD) 

e) to compare the LOD with another solution analysis method ICP-OES. 
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d) 

a) c) b) d) 

Fig. 2: Turning on of LA-ICP-MS, a) argon b) cooling, c) helium into collision cell. 

 

a) 

c) 

d) 

b) 

Fig. 3: ICP-MS configuration. Fig. 4: Set up of method for ICP-MS. 

a) 

b) 

Fig. 5: Ignite the plasma. 

 Turning on the spectrometer: 

Turn the argon (Fig. 2a) valves on the wall so that the machines have access to a flow of the 

gases. Turn on the cooling system (Fig. 2b). Now open the valve on the helium cylinder (Fig. 

2c). Finally, turn on the computer.  

 

 

 

 

 

First of all, set up measurement of solution analysis → open the program Configuration, → 

Sample introduction - Type click Peristaltic Pump (Fig. 3a). Now click Miscellaneous  

(Fig. 3b) → SC Cooling (Fig. 3c) → OK (Fig. 3d) → OK. Then open in PC program ICP-MS-

Top. 

 

 

 

 

 

 

 Analysis process:  
 

a) Ignite the plasma 

 

 

 

. 

In order to start ICP move to the ICP-MS-Top 

program and click on the plasma on icon (Fig. 5). 

Wait for 45 minutes after the plasma is ignited to 

start measurements. Use this icon      and set up 

the program for solution analysis → file → Load 

Tuning Parameter File → He_roz.U → OK. 
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Fig. 6: Program of peristaltic pump. 

Fig. 7: Setting the acquisition method  

a) 

d) 

b) 

c) 

 

b) Set up the method of analysis 

In folder data and methods create own folder with 

analysis date. Next set up the parameters of 

method analysis ICP-MS-Top: Click to upper 

icon Methods → Edit entire methods (Fig. 4a) → 

select Method information a Aquisition → ok → 

create a description of the analysis being performed 

(copper amount determination in ink) → 

Acquisition mode – spectrum (Fig. 4b) → ok → 

periodic table (Fig. 7a) select 
63

Cu and 
66

Zn – 

internal standard (Fig. 7b) → integration time 

(Fig. 7c) 
63

Cu fill 0.1 s → OK →  Peristaltic pump → Uptake Speed: 0.50 rps, Uptake 

Time: 40 sec, Stabilization Time: 10 sec. 

 

Now click DataAnalysis (Fig. 7d) → Main panel → now is opening the program Online 

ICP-MS Data Analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c) ICP-MS Data Analysis  

Once the data analysis program opens select the folder icon with a plus mark (Fig. 8a, here will 

be saved the results) → click data → name the folder → create (Fig. 8b).  

Now go to the DA Method (Fig. 8c) → click edit → Analys. Mode. → select Spectrum (Fig. 8d).  

Then click the green arrow icon. (Fig. 8e) → Load List with element of interest → Methods and 

select the name of the folder → now you see the elements of interests → click the green arrow 

icon again  (Fig. 8e)→ set up the units (ppb) and concentration of standards (0, 100, 500, 1000 

Fig. 9a) → Return to Batch-at-a-Glance (Fig. 9b) → yes. 

 

c) 



16 
 

Fig. 9: Setting the calibration  parameters. 

a) 

b) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a) 

Fig. 8: Setting the measurement  parameters in ICP-MS Data Analysis. 

a) c) 

d) 

e) 

b) 

c) 
a) 
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Fig. 10: Start Run. 

 Preparation of calibration standards  

We will use the methods of calibration curve for quantification of copper in ink (with respect 

to Zinc as internal standard). It is necessary to utilize internal standard because of matrix 

effect which can lead to signal distortion. It is chosen according these criteria: a) similar atom 

mass b) it is not present in the sample c) degree of ionisation in ICP is similar.  

Prepare copper calibration standards with concentration 0, 100, 500 a 1000 µg/l in 100 ml 

volumetric flask from stock solution with concentration Cu 1 g/l. Next prepare zinc internal 

standard with concentration 200 µg/l from stock (1 g/l). Fill the values in the table 1. 

 

Cu 

Concentration [µg/l] 0 100 500 1000 

Pipetted volume[µl]     

Zn (internal standard) 

Concentration [µg/l] 200 

Pipetted volume [µl]  

 

 

 Samples 

Sample which was prepared in cryogenic mill and after microwave mineralization is 

necessary to dilute 10x.  

 

 Start run 

 
Now start run in program ICP-MS-Top → Method → Run → 

Browse (find your folder) → OK → name your measurement 

(only 7 letters) → in Sample Type click  CalStd (Fig. 10) → 

Cal Level → 1 (measure the lowest concentration calibration 

standard) → Run Method → put the tube in your sample → 

OK. Mearsure all calibration standards according this 

procedure and increase the Cal Level. Then measure blank 

(10 x) and your sample (3x). See instruction ICP-OES for 

statistical evaluation.  

 

 

 Data export  

 

Export the table of your masured data (Fig 11) in program ICP-MS Data Analysis → file → 

export → export table → save in your own folder. 

 

 

Table 1: Calculation of addition to calibration and internal standards. 
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 Evaluation: 

Calculate the concentration of copper with respect to dilution, blank and internal standard 

(zinc) and convert it to the amount of copper (mtot) in [µg] in ink on whole paper surface (100 

cm
2
) and then to the amount of copper in one shot of laser (mCu) [fg] (see instruction for LA-

ICP-MS).  

Correction of copper concentration with respect to internal standard. 

 𝑐𝑟
𝐶𝑢 =  

𝑐𝑟
𝑍𝑛

𝑐𝑛
𝑍𝑛  ∙  𝑐𝑛

𝐶𝑢
 

WHERE: 

cr
Cu

 real copper concentration Cu 

cr
Zn

 real zinc concentration – average of measured (Fig. 11). 

cn
Cu

 concentration of copper which you measured in sample 

cn
Zn

 concentration of zinc which you measured in sample 

 

 

 

 

Fig. 11: data export. 
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Total copper content [µg] in ink on whole paper surface (100 cm
2
): 

𝑚𝑡𝑜𝑡 =  
𝑐𝑟

𝐶𝑢  ∙  𝑉

𝑚𝑀𝑊
 ∙  𝑚𝑐𝑟𝑦𝑜  

Where: 

mtot total copper content [µg] 

V  sample volume in volumetric flask 

mMW sample weight before microwave decomposition 

mcryo sample weight before cryogenic decomposition  

Now convert it to amount of copper in one shot of laser mCu [fg] see instruction LA-ICP-MS, 

quotation 2 and then to [fg / cm
2
]. Compare it with solution analysis by ICP-OES via statistic 

evaluation (see. Instruction ICP-OES). LOD convert to the paper surface. 

Lab report has to contain: 

 Calculation of copper concentration in sample. 

 Total content of copper (include the calculations) in ink on whole paper surface in 

µg/cm
2
. 

 Statistical comparison of two solution analysis methods (ICP-MS a ICP-OES) via 

LOD. 

 Evaluate your results. 
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Laser Ablation based methods: LA-ICP-MS 
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Imaging of elements in biological tissues by means of  

LA-ICP-MS 

 

Imaging of elements in biological tissues is one of the most frequent application laser ablation 

technique combined with mass spectrometry of inductively coupled plasma (LA-ICP-MS). In 

the last decades, this analytical technique was developed as a powerful elemental bioimaging 

method with very good limits of detection (sub µg/g) and high spatial resolution (micrometer 

scale). It can open the way to an understanding of the transport of essential or trace elements 

such as Cu, Zn or Pt from cytostatic drugs during the treatment period. 

 

The aim of this practicum is: 

 

f) to optimize the lateral distribution (a choice of suitable scan speed) 

g) preparation of set of calibration standards based on an agarose gel 

h) to image and quantify the distribution of Cu, Zn and Pt in tumour tissue from a mouse 

treated by platinum cytostatic drug 

i) to calculate the limit of detection (LOD) 

j) to compare the LOD with another imaging method – LIBS. 

 

1) Principle 
 

The LA-ICP-MS setup consists of laser ablation system used for creation dry aerosol removed 

from the sample and ICP-MS used for the elemental analysis of the ablated material. . 

Focusing laser beam interacts with the sample surface, then the ablated material is transported 

by a carrier gas (He) as a dry aerosol to the ICP-MS. The plasma is a high energetic source 

and the ablated material is atomized, excited and ionized. Resulting ions enter into the mass 

spectrometer where are separated according to their mass to charge ratio (m/z) and detected 

by the electron multiplier. 

 

Laser ablation 

There are several processes when the laser beam interacts with the sample surface. The 

sample surface is sharply warmed even in particular depth under the sample. A sudden 

increase in pressure cases an explosion and a destruction of the surface layer (Fig. 1a) and 

evaporated and atomized material absorbs further laser radiation with subsequent creation of 

excited atoms and ions from the sample and surrounding gas which results in a creation of 

laser induced plasma and ablated material. The particle size distribution of the ablated 

material is dependent on laser ablation parameters such as are wavelength of the laser 

radiation, its laser beam fluence and repetition rate. In most cases the particle size distribution 

has bimodal distribution (Fig. 1b) when the largest amount of particles is in range of tens nm. 

This particles are created at laser ablation process and was not agglomerate into larger 

particle. The second maximum of the distribution is about hundreds nm and this particles 
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were created by agglomeration of smaller particles. The large particles are not atomized 

completely in comparison with the smaller one and it results in changes of ICP-MS signal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1: a) Laser interaction with sample surface 

http://blogs.maryville.edu/aas/files/2013/06/ablation_diagram.jpg  

b) Particle size distribution formed by laser ablation 

(https://media.springernature.com/lw685/springer-static/image/art%3A10.1038%2Fs41598-017-

03275-x/MediaObjects/41598_2017_3275_Fig4_HTML.jpg)  

c) Inductively coupled plasma  

(https://chem.libretexts.org/@api/deki/files/100468/icp-

use.png?revision=1&size=bestfit&width=309&height=451)  

d) Dependence of ionisation degree to ionisation energy 

 (http://slideplayer.cz/slide/4108925/12/images/9/Ioniza%C4%8Dn%C3%AD+energie+(eV).jpg) 

 
 

a) 

c) 

d) 
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Sample with  

carrier gas 

http://blogs.maryville.edu/aas/files/2013/06/ablation_diagram.jpg
https://media.springernature.com/lw685/springer-static/image/art%3A10.1038%2Fs41598-017-03275-x/MediaObjects/41598_2017_3275_Fig4_HTML.jpg
https://media.springernature.com/lw685/springer-static/image/art%3A10.1038%2Fs41598-017-03275-x/MediaObjects/41598_2017_3275_Fig4_HTML.jpg
https://chem.libretexts.org/@api/deki/files/100468/icp-use.png?revision=1&size=bestfit&width=309&height=451
https://chem.libretexts.org/@api/deki/files/100468/icp-use.png?revision=1&size=bestfit&width=309&height=451
http://slideplayer.cz/slide/4108925/12/images/9/Ioniza%C4%8Dn%C3%AD+energie+(eV).jpg)
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Inductively coupled plasma 

Aerosol of the sample created by laser ablation is transported by carrier gas into the plasma torch, 

where (in high frequency magnetic field) argon plasma is created. Argon plasma is formed by plasma 

and auxiliary gas (Fig. 2c). Plasma is said to be the fourth state of matter due to its properties, which 

are very different from liquid or gas. 

Definition: 

Plasma is quasineutral gas of charged and uncharged particles, exhibits collection behaviour. 

Collective behaviour is a movement of particles depending on local conditions and the state of plasma 

in remote area. 

 

Even though plasma can be created from any gas, noble gases are preferred thanks to their simple 

spectra, to not creating stable compounds and not dissociating the atoms. They have high of ionisation 

energy (Ar – first ionisation energy 15.8 eV) as well which leads to capability of ionisation of each 

element except for He, Ne and F (see Fig. 1d). Plasma temperature ranges between 6 000 – 10 000 K, 

depending on plasma region. Electron concentration in ICP is in range of 10
20

 – 10
21

 m
-3

 which is 

significantly higher amount than in flame (10
14 

– 10
17

 m
-3

).  

 

Mass spectrometer 

Ions created in the ICP source enter into mass spectrometer via interface system. The interface 

consists of sampler and skimmer cones and there is an effective separation of argon flow from 

atoms and ions flow occurred here. First the plasma beam (ions and atoms from the sample 

and carrier gas) go through the sampler cone into pre-vacuum space with pressure of 100 Pa, 

approximately. The supersonic expansion occurs with subsequent cooling of the plasma beam. 

Then it enters into ion optic via skimmer. The ion optic serves to focusing of the beam and 

removing of photons and non-charged atoms that would increase the background level of the 

detector. Focused ion beam enters into collision-reaction cell filled with He that suppress 

possible polyatomic interferences. Then the ions are separated in the quadrupole analyser 

according to their mass to charge ratio (m/z) and ions with selected m/z exit from the analyser 

and hit the electron multiplier that generates signal.  

 

 

 

 

 

 

 

  



24 
 

Fig. 2: Instrumentation of laser ablation with inductively coupled plasma and mass spectrometry 

(LA-ICP-MS). (D. Günther, B. Hattendorf, TrAC (2005), 24(3), 255-265). 

 

  

 

 

 

 

 

 

2) Experimental Procedure: 

 
 Preparation of calibration standards  

 

Prepare 5 calibration agarose gel standards with addition of standard solution according  

the table 1. 

 

 Agarose gel 

Addition of standard a b c d e 

Pt [µg ∙ g
-1

] 0 1 2 10 20 

Cu, Zn [µg ∙ g
-1

] 0 10 20 50 100 

 

 

 

 

Prepare the working solution (100 ml) that contains 100 mg ∙ l
-1 

of Pt, Cu, Zn from a stock solutions 1 

with concentration of 1 g ∙ l
-1

. Calculated volume [µl] of the addition from working solution 2 add to 

0.1 g agarose and add up to 5 ml of MQ water in small beaker. Then put it on the magnetic hotplate 

stirrer and boil it weakly under constant stirring until it becomes homogeneous (5 min, approx., see 

Tab. 1: addition of standard to agarose gels. 
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Fig. 3). 100 µl of mixture pipette on the small glass slide and let to gel. Then attach the 5 small glasses 

to the large glass slide with the double sided adhesive tape.   

 

 

                                                
1

2

3

4
5 6

7

8

9

1 10

2

3

4
5 6

7

8

9
11

 

 

 

 

 Agarose gel 

Standard addition a b c d e 

Pt [µl] -     

Cu, Zn [µl] -     

Water [ml] 5     

 

 

Fill the calculated amount of working solutions into Tab.2. 

 

 

 Sample handling 

 

Remove the sample holder from the ablation chamber and put the sample 

of the tissue and glass with calibration standard on it (Fig. 4) and attach it 

with the double sided adhesive tape to secure against a movement of the 

sample in ablation chamber during laser ablation.  

 

 

 

Solution 1 Solution 2 

Agarose 

gel 

? µl 

10 x diluted 

? µl 

1 g ∙ l
-1 

Tab. 2: Calculated standard addition [µl] to agarose gels. 

 

Fig. 3: Preparation of calibration standards. 

 

Fig. 4: Sample handling. 
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a) c) e) b) d) 

Fig. 5: Turn on of individual parts of instrument LA-ICP-MS, a) argon, helium, b) cooling, c) 

helium to collision-reaction cell, d) and e) laser. 
 

3) LA-ICP-MS Measurement 
 

Turning on the machines: 

Turn the argon and helium (Fig. 5a) valves on the wall so that the machines have access to a flow of 

the gases. Turn on the cooling system (Fig. 5b). Now open the valve on the helium cylinder (Fig. 5c). 

In order to turn on the laser, flip the switch on the back of the machine 

(Fig. 5d) and turn the key found under the machine (Fig. 5e). Turn on the flow meter. Finally, turn on 

the computer.  

 

Now open the desktop programs New Wave Research – Laser Ablation, ICP-MS-Top, and Smart 

Control. On the Smart Control system select file, open, and then find the serial number of the 

flowmeter. Now click OK. On this display 100% flow is a flow rate of 2.00 L/min.  

 

 

The air in the ablation chamber must be flushed after the ablation chamber is opened. In order to do 

this, go to the New Wave Research program and switch the system from bypass mode to purge mode 

as shown in figure 6.  

 

 

 

Fig. 6: Switching the mode from bypass to purge to online.  
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Now move to the Smart Control program and increase the Helium flow to 50% (1.00 L/min). Allow 

the ablation chamber to be washed for approximately 1 minute and just before the ablation chamber 

moves from the purge mode to the online mode, reduce the He flow to 1%.  

 

 

ICP-MS-Top 

 

In order to start ICP move to the ICP-MS-Top program and click on the plasma on icon. The plasma 

igniting should be visible on the Mass Spectrometer (Fig. 7). Wait for 45 minutes after the plasma is 

ignited to start measurements. During the waiting period, it is a good idea to start setting up the 

methods.  

 

 

Fig. 7: Ignited plasma in the Mass Spectrometer. 

 

In the folder data and methods create new folder and name the folder after the analysis date. Now the 

ICP-MS-Top measurement conditions must be set.  

Methods → Edit entire methods → select Method information a Aquisition → ok → create a 

description of the analysis being performed → Time Resolved Analysis → ok → periodic table (select 

the elements being analyzed) → the integration time for each element should be as follows: Carbon 

0.01s, Silicon 0.1s, Copper 0.1s, Zinc 0.1s, Platinum 0.3s.  → Real Time Plot select extract → Time 

window → 500 s → OK → Aquisition → 9990 s (max. time analysis) → OK. 

 

ICP-MS Data Analysis  

 

Once the data analysis program opens select the folder icon with a plus mark. Click data. Name the 

folder. Click create. Now go to the DA Method tab. → click edit → Analys. Mode. → select 

Timechard (Fig. 8).  Then click the green arrow icon. → Load List with element of interest → 

Methods and select the name of the folder (Fig. 8). Click Batch-at-a-glance on the right → yes.  
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Fig. 8: Editing the data analysis information.  

 

Fig. 9: Selecting the correct folder for data analysis. 

 

 

 

New Wave Research 

 

Now move to the New Wave Research software. Set the frequency to 10 Hz (fig. 10a), the laser beam 

size to 100 µm (fig. 10b), the energy to 96 % (cca 8 J/cm
2
) (fig. 10c).  

 

 

 

 

 

 

 

 

 

 

Now it is necessary to prepare an ablation pattern for each sample. Using the microscope find the 

outline of the tissue sample and note the leftmost, rightmost, topmost, and bottommost points of the 

tissue. Now click tools, select line and create a line on the page (left click, drag, left click, right click). 

On the left-hand side of the screen under scan patterns select the line just created and right click (Fig. 

11a). Now click on edit endpoints (Fig. 11b). Edit the X coordinates to be the leftmost and rightmost 

points. Edit both the Y coordinates to be the topmost point. Click OK. Now right click the line again 

and select properties. Change the scan speed to 200 µm/sec  

(Fig. 12a), the output energy to 96 % (Fig. 12b), the spot size to 100 µm (Fig. 12c), and then check 

Default (Fig. 112d). Click OK (Fig. 12e).  

Fig. 10: a) Frequency, b) laser beam size, c) energy percentage 

 

a b c 
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Right click the line again and select Duplicate Scans. Each line should be 0.11 mm apart, so based on 

the length of the tissue determine the number of copies necessary to create the grid (Fig. 13). Enter this 

number and click OK. Make sure that the grid encompasses the entire tissue area.  

 

 

 

 

 

 

 

 

 

 

 

One line for each calibration standard must also be created. Each line should be at least 2 mm in width 

of the calibration gel.  

  

Now go back to ICP-MS-Top software and select Method and then Run. Choose where the results 

should be saved. Click OK. Name the measurement (only use 7 letters). Click Run Method. The ICP-

MS-Top software will start collecting data and should show data looking similar to figure 14.  

In the New Wave Research program click Run Experiment and select Enable Laser During Scans. 

Change the laser warm up time to 5 seconds. Then click Run.  

a 

b 

a 

b c 

d e 

Fig. 13: Adjusting the copy pattern.  

 

Fig. 11: a) Selecting the line, b) edit 

size, endpoints 
Fig. 12: a) scan speed, b) output energy, c) spot d) 

select default, e) OK 
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Once the laser has gone through the entire ablation pattern click Stop Run in the ICP-MS Top 

program.  

Importing the Results: 

Using the ICP-MS Data Analysis program and select File → import samples, select the folder made 

earlier, and click OK. On the chart below right click and select Tabulate Chart and then select csv 

Data (Fig. 15). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 14: ICP-MS-Top software after starting to run the method.  

 

Fig. 15: Converting the data into csv file.  

.  
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The data collected should look similar to the data in figure 16.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Turning off the device: 

In the ICP-MS-Top program click the plasma off icon at the top left portion of the screen. Now close 

all programs and shut down the computer, the cooler, and the laser. The gases must also be switched 

off.  

 

Creating the maps: 

Start by opening the Laser Ablation Tool program. Click load data from selected file and choose the 

csv file. Click next. Now sync one of the elements by setting the start time of the measurement. Next 

set the rising and falling steps as well as the period of signal. Continue adjusting these settings until 

the intervals on the graph turn gray, as shown in figure 17.  

Click next and set the speed of the laser and the distance between the two laser tracks (the distance 

should be 110 µm).  Then click finish.  

 

To save the collected data click the XLS icon at the top left corner, name the file, and save it.  

 

Now open the file in excel. There should be an excel sheet for each element. Select an element and 

highlight all of the data. Then, go to insert and under graphs click on templates. Select the template 

with the icon shown in figure 18.  

 

 

Fig. 16: Data in converted from the ICP-MS data analysis to csv format.  
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Fig. 17: Using the laser ablation tool to sync each element. 

 

 

Fig. 18: Selecting an appropriate template for the map. 
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Fig. 19: Correction of picture aspect ratio. 

 

Once the graph is created, right click, click move graph → new sheet → and then name the graph. 

Next, right click on the edge of the graph and click on format axis. Adjust the minimum and maximum 

values to create an appropriate range for the legend. The main unit should be one order lower than the 

maximum.  

 

Now, use the cutting tool on the computer to cut out the graph from the excel sheet. Save the image 

and then open it with the program XnView (any other enabling basic image processing). It is 

necessary to adjust the aspect ratios of image (see excel µm x µm) → picture → size → (Fig. 19) and 

save it. Create panoramic picture with scale → panorama → add (Fig. 20a) → select our picture → 

add (Fig. 20b) → add scale picture as well → ok (Fig. 20c) → create (Fig. 20d). 
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Fig. 21: Description of scale. 

 

 

At the end insert the describtion of scale (units, name of sample, etc.) → picture → add text → write a 

text (Fig. 21) → ok → use the mouse to select the position of text in picture → save picture. 

 

 

 

 

Fig. 20: Creation of panoramic picture. 

b) 

 

c) 

 

a) 

 

d) 
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EVALUATION: 

 There are 2 very important parameters which have to be optimize before you start to measure 

the real samples. Scan speed [µm ∙ s
 -1

] influence the a) relative broadening Δwrel (equation 5) end 

thereby lateral resolution and b) time of analysis.  One of the other important parameter is c) 

sensitivity which is expressed by limit of detection (LOD). You will calculate LOD1 of Cu in ink to 

compare LIBS and LA-ICP-MS and LOD2,3,4 of tissue sample for each determined element (Cu, Pt, 

Zn).  

 

 Amount of copper [fg] in one shot of laser: 

 

It is known the total copper content (mtot) on the paper (Stot - Fig. 23) determined by solution 

analysis via ICP-MS. Now convert it to the copper amount in one shot of laser (mCu) according the 

equation (1) and (2). Diameter of laser spot is 100 µm. 

 

 

 

 

 

𝑆𝑝 =  𝜋𝑟2 = 3,14 ∙ 502 = 7854 𝜇𝑚2 

 (1) 

 

𝑚𝐶𝑢 =  
𝑆𝑝 ∙ 𝑚𝑡𝑜𝑡

𝑆𝑡𝑜𝑡
    

 (2) 

 

 

 

 

 

 

 

 Limit of detection (ink): 

Calculate for each scan speed and compare (fig. 22). 

     𝐿𝑂𝐷1 =
3 ∙𝑆𝐷∙ 𝑚𝐶𝑢

𝐼𝐶𝑢
    (3) 

 

Fig. 22: Different scan speed line by line. 

 
Sp 

w 

80 µm ∙ s-1 

100 µm ∙ s-1 

150 µm ∙ s-1 

200 µm ∙ s-1 

300 µm ∙ s-1 

400 µm ∙ s-1 

500 µm ∙ s-1 

1000 µm ∙ s-1 

1
00

 m
m

 

Stot 

100 mm 

Fig. 23: Original paper size. 
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WHERE: 

 

SD is standard deviation of background (10 values of background – intensity of copper before the 

starting ablation). 

ICu is average intensity of Cu (5 values of intensity in ink line during the ablation)  

mCu is amount of copper [fg] in one shot of laser (diameter of laser spot 100 µm). 

 

Convert LOD1 to [fg/µm
2
]. 

 

 

 Limit of detection in tissue sample: 

 

𝐿𝑂𝐷𝑍𝑛 =
3 ∙𝑆𝐷

𝐺𝐿𝑍𝑛
     (4) 

 

WHERE: 

 

SD is standard deviation of background (10 values of background – intensity of zinc before the 

starting ablation). 

GLZn is guideline of calibration curve (the average amount of the line intensities is plotted to y-axis 

and concentration of added amount [µg/g] of element of interest to x-axis).  

 

 

 Relative broadening (ΔWrel): 

Lateral resolution of imaging is quantified as relative broadening (Δwrel) of width ink line (w) – 

(fig. 22) measure it by microscope in program New Wave Research - Laser Ablation System, 

 

∆𝑊𝑟𝑒𝑙 =  
∆𝑤𝑎𝑝𝑝− 𝑤

𝑤
 ∙ 100     (5) 

where wapp is measured width line and w is real width of the ink line (Fig. 24). 
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Lab report has to contain: 

 

 Pictures of quantitative determination of copper and zinc distribution in tumour tissue. 

 Calculation of LOD1 [fg/µm
2
], LODZn,Cu, Pt [µg/g] and relative broadening ΔWrel [%] 

 According LOD1 and ΔWrel compare two imaging method LA-ICP-MS and LIBS and with 

LOD1 compare method of solution analysis (ICP-MS and ICP-OES) as well. 

 

 

Fig. 24: Record of line scan speed 200 µm/s and the laser spot diameter 100 µm together with 

determination of apparent width Wapp which was obtained as the trend intersections of line 1 and 2 and 

trend lines 3 and 4, respectively. These intersections indicate the onset and end points of 
63

Cu signal 

intensity in ink line. 
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Laser-Induced Breakdown Spectroscopy LIBS 
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Determination of Cu in a blue print by LIBS technique 

 

Principle 
Laser-Induced Breakdown Spectroscopy (LIBS) is a method of atomic emission 
spectroscopy which uses radiation of microplasma created by the interaction of focused laser 
beam with the sample surface. 
 
Laser beam reaching the sample surface causes rapid heating of the material and 
subsequent ablation. Small amount of the material is being released (in the order of tens to 
hundreds of ng) and a radiation of microplasma created is detected and evaluated. After the 
end of the pulse microplasma is expanding and continuous bremsstrahlung is emitted. After 
a moment in the order of hundreds of ns microplasma starts to cool down rapidly, the 
intensity of bremsstrahlung decreases and characteristic emission lines of the atoms and 
ions are left in the spectrum. It is possible to determine the elemental composition of the 
sample based on matching the lines observed to particular elements (Fig. 1). 
 

 
Fig. 1 Scheme of the processes in Laser-Induced Breakdown Spectroscopy [1] 

 

The method doesn’t require any sample preparation and it is possible to measure in the air at 
the atmospheric pressure. Possibility of remote measurements is among the advantages of 
this method, either with so called remote LIBS using an optical fibre or stand-off LIBS with a 
telescope. LIBS is microdestructive and, therefore, usable when other methods of sampling 
are too destructive. 
Thanks to a good spatial resolution depth-resolved analysis (Fig. 2) can be carried out and 
maps of elemental distribution (Fig. 3) can be created. During the depth-resolved analysis 
the laser pulse is repeatedly directed to one point, one spectrum is acquired for each pulse 
and intensity of significant line as a function of number of pulses is observed. Depth profiling 
can be used e.g. to distinguish layers of multi-layered surfaces. Elemental distribution 
analysis is carried out in a pre-set grid of points in the area of interest. One pulse is directed 
to one point of the grid and a spectrum is acquired.  Elements present in the area of interest 
can be given different colours and illustrative maps of their distribution can be created.  
 

  
Fig. 2 Example of the depth profile of a three-layered sample Fig. 3 Elemental distribution of Al 
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Instrumentation 
Modified ablation system New Wawe UP-266 MACRO (Fig. 4) is equipped with a solid-state 
Nd:YAG laser operating at fourth harmonic frequency (~ 266 nm). The sample holder can be 
moved in x and y axes using a software, while the sample is recorded with a camera. That 
enables scanning of the sample surface. Measurements are usually carried out in the air at 
the atmospheric pressure. However, the environment of the sample and the pressure can be 
adjusted by using the ablation cell. Emission of microplasma is recorded and transmitted 
through an optical fibre to a Czerny-Turner monochromator (Jobin Yvon, TRIAX 320, 
Francie) and it is detected  by an intensified CCD (iCCD) camera (PI-MAX 3, Princeton 
Instruments, USA). The intensity of the signal is then evaluated as a function of wavelength 
and can be further elaborated.  
 

 
Fig. 4 New Wawe UP-266 MACRO 

 

Turning-on: 
 
1) Turn on the power supply of the laser system UP-266 MACRO 
2) Turn on the laser UP-266 MACRO with a 0/I switch in the back  
3) Turn on the Dell computer (black one) 
4) Turn on the MEO laser program 

 

 

  
 

 

 

 

5) Turn on both delay generators by turning the POWER switch to ON 

1)                    3)            

2) 
4) 
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6) Turn on the pulse generator and divider, both values are pre-set to 005 (~ 2 Hz) 
7) Turn on the source and the control unit of the detector using the 0/I switch in the back of 

the source 
8) Turn on the HP computer (silver) 

   
9) Turn on Winspec program, choose Restore to last setting. 

 

   
 

10) Turn on the ICCD camera using the ON/OFF switch in the back of the detector 
 

 
  

5) 

6) 

7) 
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Analysis procedure 

1) Sample preparation 
Cut out the printed sample. Adjust the sample to the base using a double-sided adhesive 
tape. Place the base onto the sample holder. Adjust the sample using the software so it is in 
the middle and parallel to the axes in the software.  
 

   
 

Turn on the light above the sample using the Ring mode 
 

         
 

 

Focus the sample surface using the micro-shift screw. 
  

Sample holder control: 
 

 

 
 

2) Experimental set-up 

Micro-shift screw 
for up and down 
movement 

Sample holder 
with the screws 
to set the leaning  
angle of the 
sample 

Revolving screw 
for focusing 

Arresting screw  
- first loosen it, 
set the sample, 
then tighten it 
again. Secure the 
sample holder 
with your hand 
the whole time! 
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Parameters of the spectrometer and the detector are set up first using the HP computer. 
Characteristic spectral lines of copper lie at 324.7 nm and 327.4 nm. Set the wavelength in 
the Winspec program to 327 nm. Choose Spectrograph → Move…→ Move to: 327 nm. 
Grating n. 2 (2400) and a 0,6 slit are already pre-set. 
 

 
 

Choose the blue Pulse button and set the Gate Width to 5 µs and the Gate Delay to 0,5 µs. 
Press Apply. 
 

 
 
 
 
 
 
 
Choose Acquisition → Experiment Setup… → tab Main → set Number of Spectra to 1800.  
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            … → tab Data File → set the Name: SESKUPIT in 
the file C:\Program Files\Princeton Instruments\Winspec\Cviceni SESKUPIT 
 

 
 
Go to the Dell computer. Set the crater diameter size to 780 µm in the MEO laser program. 
Set the laser energy to 80%. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
In the MEO laser program choose File → Open Experiment… → open rastr 30x30 
seskupit.LAE  
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Choose Properties and check the parameters setting according to the table 
 

 
 

 
 
 
 
 
 
 
 
Set the position of the red axes cross according to the picture. Choose Options → Move 
Scans to Crosshairs. The sample should be approximately in the middle of the raster.  
 

This value has no impact on the frequency, as 

the laser is connected to the pulse divider. 
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3) Measurements 
 

In the Winspec program press the green button ACQ (Acquire). 
 

 
 
Defocus the sample using the revolving screw 
 

 
 

 

In the MEO laser program choose Run Scans → tick Manually Control Valves and Enable 
Laser During Scans 
 
!!!ALWAYS PUT ON PROTECTIVE GLASSES BEFORE TURNING THE LASER ON!!! 
 
Choose Run 
 

 
 

Measurement time ~ 25 minutes 
 

Revolving screw 
for focusing 
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Fig. 5 Raster used for surface mapping – there are 30 points of ca. 100 µm in diameter in each line, arrows show 
the direction of measurement of individual points  
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4) Data export 
In the Winspec program choose the Tools tab → Convert To ASCII 
 

 
 

Choose Choose Files → Oblast hledání: C:\Program Files\Princeton 
Instruments\Winspec\Cviceni SESKUPIT → Choose and open the last file.  
Choose Choose Output Directory → C:\Program Files\Princeton 
Instruments\Winspec\Cviceni SESKUPIT 
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Choose Convert To ASCII for selected files. Check the creation of the file SESKUPIT.txt in 
C:\Program Files\Princeton Instruments\Winspec\Cviceni SESKUPIT  
 

  
 

5) Data elaboration 
 

Copy the SESKUPIT.txt file to the desktop. Open the SESKUPIT.xlsx file on the desktop → 
choose the sheet Original data → choose the tab Data → in the first section Načíst externí 
data choose Z textu → import the SESKUPIT.txt file from the desktop 
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Do not make any changes in  Průvodce importem textu (1/3) and (2/3) and choose Další → 
in Průvodce importem textu (3/3) choose Dokončit  → in the table Importovat data check the 
data location and choose OK 
 

 
 

 
 

The system adds a vacant even-numbered line with no information to the data file. These 
even lines need to be removed. Click to A1 box in Original data sheet and press 
Ctrl+Shift+S. Data from odd-numbered lines will be copied to 1. smazání řádků. 
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Copy the 324.7 nm column from 1. smazání řádků with the maximum signal intensity to 2. 
rozdělení řádků.  
 
Regarding the course of the raster measurements (Fig. 5), it is necessary to transpose 30 
values from the column to the line, while it is necessary to both transpose and reverse the 
order of the next 30 values (change of the course in the raster in every second line) and 
repeat until the end. 
 
Click to A3 box and press Ctrl+Shift+L for transposition of the odd-numbered lines. 
Analogously press Ctrl+Shift+P for reversal and transposition of the even-numbered lines. 
Final data for elemental map creation will be displayed in Finální tabulka. 
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Mark all values in the table → choose tab Vložení → Grafy → Šablony → choose template 
according to the picture 
 

 
 

Adjust the vertical axis of the elemental map so the maximum value approximately 
corresponds to the maximum intensities.  
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In the MWSnap (camera icon on the toolbar) choose Libovolný úhelník and mark precisely 
the area of the map → save the image to the desktop → open the image in the XnView 
program 
 

   
 

 
 
In the XnView program choose the tab Nástroje → choose Panorama… 
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In Panoramatický obrázek choose Přidat… → in Zvolte soubory choose the saved map and 
choose Přidat, then choose škála 1 and Přidat → press OK → back in Panoramatický 
obrázek add selected files, then click on Vytvořit… 
 

 
 

 

Choose file Obrázek → Přidat text → add legend accorging to the picture → copy the final 
map to the lab report 
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EVALUATION: 
 

Visually compare the elemental maps acquired by both techniques (LIBS a LA-ICP-MS) and 
describe the differences.   
 
For further comparison of both techniques calculate the detection limit (LOD) and lateral 
resolution (according to Δwrel). 
 

Limit of detection calculation: 
 
 

𝐿𝑂𝐷 =
3 ∙ 𝑆𝐷 ∙  𝑚𝐶𝑢

𝐼𝐶𝑢
 

 

 

 

Where: 
SD standard deviation of the background (measured on the plain paper without print) 
ICu average intensity of Cu calculated using at least 5 values in the area of blue print (see   

LA-ICP-MS instructions) 
mCu weight of Cu in fg on the crater surface of 100 µm in diameter (see Solution analysis 

instructions) 
 

 
For the calculation of copper weight per crater surface go as follows: 
The content of Cu (mcelk) in the whole surface (Scelk) of the printed square is related to the 
crater surface calculated using the laser beam diameter of 100 µm (crater surface is actually 
bigger than the laser beam diameter, we will, however consider it equal to simplify the 
calculations). 
 

𝑆𝑝 =  𝜋𝑟2 = 3,14 ∙ 502 = 7854 𝜇𝑚2 

 

 

𝑚𝐶𝑢 =  
𝑆𝑝 ∙  𝑚𝑐𝑒𝑙𝑘

𝑆𝑐𝑒𝑙𝑘
 

 

Final limit of detection related to the crater surface [fg] will be related to the unit surface 
[µm2]. 
 

 
Relative enlargement of the printed line (ΔWrel): 
 

𝛥𝑤𝑟𝑒𝑙 =  
𝛥𝑙 − 𝑙𝑟

𝑙𝑟
 ∙ 100 

 

Where: 
Δl apparent width of the printed line from the acquired map [mm] 
lr real width of the line (measured in the MEO laser program) 
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Fig. 6 Apparent width estimation 

 

For calculation of the relative enlargement of the printed line see LA-ICP-MS imaging 

instructions using the graph (Fig. 6). 

 
 
Lab report will contain: 
 

 Images of Cu distribution in the letter A acquired by LA-ICP-MS and LIBS 

 Calculations of relative enlargement of the printed line and limit of detection 

 Comparison of the sensitivity and lateral resolution of both techniques based on these 
parameters 

 Comparison of solution analysis (ICP-OES a ICP-MS) and imaging methods (LA-ICP-
MS a LIBS) based on LOD related to the unit surface  
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